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Trykt Produkt beskrivelse

Dette er en fiktiv case

Case

Baun Studios er en dansk small business med internationale
kunder, som nu udvider til nye markeder. De planlzegger at
abne pop-up butikker i Kebenhavn, Berlin og Paris. | den for-
bindelse vil Baun Studios udgive et gratis katalog, der vil blive
uddelt i pop-up butikker, til sample sales og lignende events.
Kataloget vil vise deres nyeste kollektioner og give kunderne
give en eksklusiv oplevelse af brandet.

Krav

Da det er en small business, vil de gerne spare penge der hvor
de kan, men vil stadig gerne have et laekkert katalog.

Budget
Omkring 25.000 til 30.000

Kernefagligheder

- Grafik & billedbehandling

- Typografi & Ombrydning

- Grafisk Produktionsforstaelse




Typografi & Ombrydning

Dokumentopsaetning & Baseline Grid

Lavede et custom format sa kataloget kunne give en eksklusiv
fglelse og samtidig passe ned i en katalog stander.

Baseline Grid er slaet til, sa teksten holder register. Det er sat
til at passe brgdtekstens skydning. Det starter ved toppen af
siden, og sa har jeg rettet margin til efter, sa jeg bevarer en
god luft.

Fontvalg

Avenir Next er min main font grundet fontens laesbarhed og
alsidighed. Den er baseret pa geometriske principper, men
har humanistiske detaljer,der ggr den mere laesbar og mindre
"kold"” end rene geometriske fonte.

For at tilfgje mere personlighed, valgte jeg en sekundaer font,
Recoleta, som Baun Studio ogsa selv ggr brug af. Det er en
retro font med moderne designprincipper.

Masterpage & Pagina
Jeg har lavet to Parents i masterpage:

A-parent

e Brugt til min streg i bunden og pagina. For- og
bagside haringen Parent.

B-parent

e Lavet til steder, hvor billedet fylder hele hgjre
side og derved ingen grund til streg og pagina.

Mellemrubrik

Da Avenir Next har en hgj x-hgjde, valgte jeg en lidt hgjere
skydning for at give mere luft og optimere laesbarheden yder-
ligere. Brgdteksten er 11/15 og mellemrubrik er 12/16.

I-testen

For at fa det rigtige ordmellemrum, og undga floder, har jeg
lavet i-testen. H&J Violations er slaet til under Preferences. Der-
efter gikjeg ind i Justifications igen, og legede med teksten.

Anchored Objects
For at haegte mine anfgrelsestegn til mit citat.

Document Setup

Intent:  Print

Number of Pages:

Start Page Ne: 1

Page Size: [Custom] v

~ Bleed and Slug

Top
Bleed: | 3 mm

Slug: 0 mm

() Adjust page el
"~ changes

Preview

31Pages

[None]
A-Parent

B-Parent

Facing Pages

Orientation: [g] [-d

&
Outside:

Bottom Inside
3 mm 3mm

0 mm 0mm

lements to document Adjust Layout...

Outside
3mm

0mm

Cancel

LS CGT

Paragraph Style Options

Style Name: | brad m. i-test

Location:

Word Spacing
Letter Spacing:

Glyph Scaling:

Auto Leading:

Single Word Justification:

Composer:

Minimum Desired Maximum
70% 85% 100%
-2% 0% 2%

98% 100% | 102%

120%
Full Justify

Adobe Paragraph Composer

Ir

A-Parent

Grids

Baseline Grid
Colour: IR

Start: 0 mm

Relative To: Top of Page

Increment Every: 15 pt
View Threshold: 50%

Document Grid
(@M O Light Grey 2

Horizontal Vertical
Gridline Every: 25,4 mm Gridline Every: | 25,4

Subdivisions: 8 Subdivisions: 8

8 spalter med 4 mm. gutter

B-Parent
|
LLELELe
‘ AAAAAAAAA 1#

Avenir Next Recoleta
ABCDEFGHIJKLMN ASOR BRG]
OPQRSTUVWXYZ OPQRSTUVWXYZ
abcdefghijkimn abedefghijkimn
opgrstuvwxyz DRI
0123456789 Ollxs Slevists
‘~!@#$%/\&*()_ ~@#S%N&*()-
=N <>/ =HONG <>/
Relativ hgj x-hgjde Relativ hgj x-hgjde Lille
Overlaengde 94— overleengde
—= Blgde kurver aIﬁ C S l
[~ [ | Skiftende
Open | l Open 1 l stregtykkelse
Counters Counters Blede afrundinger

Geometrisk balance

Paragraph Style Options

Indents and Spacing

First Line Indent

Space Before

Align to Grid:  None

15 (bradtekstens skydning) x 2 = 30
30 - 16 (mellemrubrikkens skydning)= 14

Space Before: 12 pt
Space After: 2 pt

varigvaerdi-og komfortforvores kunder:

1

Vésigtermodatskabe
»# mode, derbddeer «
baeredygtig og stilfuld:
Ved at prioritere-bade funktionalitet og

miljgansvar sigter.vi.mod-at-skape lang=
tidsholdbare, hgj-kvalitets produkter,

Paragraph Style Options

Right Indent: | <
Last Line In

S

15 (bradtekstens skydning) x 3 = 45

45 -16 - 16 (mellemrubrikkens skydning)= 13
Space Before: 11 pt

Space After: 2 pt

»Glitter is always
an option«™

o




71

commerTe T

Row Separator: Paragraph v

QI (sasic Table] v

O119-expanded.psd

Deto ed
3anuar|Snesk peskph nykollskton |Onine [10:00 Deto Seghenhed e
ETX I P paEv— TP 3janusr |Snoak paak pa ny kollektion [Onlina [10:00
24 Tebraar | Grandimgger Alberie Mt [Onine [ 1400 T2 febraar | Pop Up Store Kobenhaun [12:00

forvmiler msin process
20.mars | influencer Kolsktion Gaine 1690 24 fobruar | Grundimggor Alberte Muff_|Onlne | 14:00
sk perk fortmllerom sinprocess
ot |Solng Ty e [1300
ing T 20, mars | nvencerKolekvo S ey
o 2prt Kon 10:00 0.mats |Stying Tips .
2l Oane 1200
aprl|Semple Sale ConvertTbl to Txt.
e AT
nzeit Row(3) 2 ma) Bag Kulissere | Table Options.
70.jum callOptions
25.mal|Baun Babes Fokus
o augut
o |
0. november |Black
T8.august | Pop Up Store
| 15. docember [ Inuen

12/02/25
11:00-18:00

24/02/25

Pop Up Butik

Bag Kulisserne

1000-1200

20/03/25
415001530

30/03/25

HTML...
te QR Code...

Extract from Image >
Anchored Object >
Fitting >
Content 9
Effects >

Corner Options...

Obiject Layer Options.... .

‘Object Export Options... I

Captions > |

Clipping Path > Generate Live Caption

Image Colour Settings...
Interactive

Paths

Pathfinder

Convert Shape
Convert Point

Data Merge

Generate Static Caption

'

Dato

12/02/25
11:00 - 18:00

24/02/25
10:00 - 12:00

20/03/25
15:00 - 15:30

[ Gradient

B sory

@ Hyperinks

Select Data Source.

Export To PDF
Update Data Source

Remove Data Source

Preview

Create Merged Document.
Update Content i Data Fields

Content Placement Options...

§

Pr—

395,000KK. 395,000KK

Caption Setup

Influencer
Sneak Pea

595,000k 895,000KK.

.
Vores blé glitter bukser
Stylet med vores
assymetriske top

o
Caption Setup...
Generate Live Caption

R
Dato Event
Open Recent
20225 g

11:00- 18:00 Close o
save 2

24/02/25 A

102 Bag Kulisserne e

1000-12:00
Savea Copy...

20/03/25

1500-15:30

Soarch Adobe Stock...

=2 Dato

12/02/25
11:00 - 18:00

Bag Ku
10:00 ¥
Charact ¢ Character Styles

tabel - datoer

fremid for alle.

M\gaermet top i hvid med glitrende
stof. Den ideelle top til at tilfoje ele-
gance og sikrer, at du skiller dig ud
med et klassisk udtryk.

495,00 DK

Object Styles

pris boks.
[None]

Strol Grac

[Basic Graphics Frame]

[Basic Text Frame]

pris boks

Lit Pa ¢ Paragraph Styles 8 general

brod
glitter citat (general)
brad m. i-test
(Basic Paragraph]
_ mellemrubrik - 1 linje
88 auto indholdsfortegnelse
mellemrubrik - 2 linjer
auto tabel - kapitler
overskrift 69/72
auto tabel - tal
overskift - 49/52
8 dat:
L) responsibility
overskrift - DM
citat boks
smd overskrifter - DM s G
produkt info u. bullet - DM Indiedning
GiB=CI billedtekst
produkt info m. bullet - DM B side 22

88 tabel (kommende planer) overskiift - 22/26

tabel - overskrift underrubrikker...(avenir next)

tabel - brad beskrivelse

tabel - info nederst produkt info

8 masterpage detaljer m. bullets & indryk

pagina

Charact © Character Styles Dansk orddeling

Engelsk orddeling
[None]

(None] [E]

15%
i side 22
SOME tekst

B vagte
light oblique (avenir next)

medium (avenir next)

bold (avenir next)

[ tabel (kommende planer)
tabel - demi bold
tabel - datoer

~ [l citater
citat tegn
citat tegn - store

glitter citat - ...ic (avenir next)

Vores Mission

Endeligtervores mission at kunne| | -

trzffe gennemtaenkie valg gennem

mél er at demonstrere, at beredygtighed og
e

Object Style Options

pris boks

Al

Typografi & Ombrydning

Tabel

Har fgrst skrevet en tekst med tabs, som jeg har convertet
til en tabel. Derefter tilfgjede jeg en reekke ovenover sa jeg
kunne placere et billede inde i tabellen. Jeg stylede tabellen
og brugte bade Paragraph- og Character Style.

Paragraph- & Character Style
Oversigt over alle styles jeg har brugt.

Data Merge

Jeg lavede Data Merge for at optimere mit workflow. Skrev alle
produkterne, beskrivelser mm. i Excel og gemte derefter som
TXT filer i hver deres mappe for at bevare overblikket. Derefter
lavede jeg en template og stylede indtil jeg var tilfreds. Hen-
tede TXT filen ind i mit Indesign og overfgrte dataen fra filen
til min template.

Text Wrap

Fritlagde modellen og brugte Text Wrap til at fa teksten til at
wrappe fra hendes venstre side.

Captions
Gennem Photoshop har jeg tilfgjet en billedtekst, som har faet
sin egen Paragraph Style. Brugte Generate Static.

Object Style

Lavede flere designs i Object Style (fx. min priskasse) sa jeg
kunne skifte design mere effektivt, efter behov.



Grafik & Billedbehandling

Billederne

Billederne er en blanding af materiale 1ant fra Baun Studios
ejer, og ellers stock. Nogle af dem har jeg brugt Generative Fill
til for at udvide baggrunden og give mig mere plads.

Rentegning
Jeg rentegnede ikoner i lllustrator med Pen Tool og Shapes.

Fritleegning

Pentool har veeret mit foretrukne vaerktgj. Jeg har engang i
mellem brugt Select and mask nar modellerne har haft meget
glat har.

Fritlaegning af har med Channels

Via Channels, valgte jeg den kanal med mest kontrast og ko-
pierede den for at arbejde non-destruktivt. Brugte levels til at
forstaerke kontrasterne og fritlagde bagefter med Pen tool.
Malede krgllerne fremn med en blgd brush pa Overlay og flow
pa 40% for en naturlig effekt. Jeg har brugt stamp tool til at
give haret mere fylde.

Custom Brush

For at fa tabte krgller frem, valgte jeg at lave et par forskellige
brushes. Fgrste brush, lavede jeg ved at lave en halvmane.
Bagefterind under "Brush Settings” og aendrede blandt andet
hvordan brush strokesene skulle fordele sig, rotere, rundingen
mm. indtil jeg var tilfreds. Derefter valgte jeg Edit, "Define
Brush Preset” og gemte brushen. Anden brush er lavet ved at
markere en krglle fra modellen og valgte "define brush preset”.

Retouch - Spot Healing Brush og Remove Tool

Til sma meerker, fregner eller bumser, lavede jeg et lag for sig
og brugte Spot Healing Brush. Til ting sdsom ar, smilerynker
og tattoos brugte jeg Remove Tool. Jeg ville ikke have et alt for
"clean” udtryk, sa jeg skruede opaciteten en smule ned ofte
for en mere naturlig effekt.

Liquify

Jeg lavede laget til Smart Object for at arbejde non-des-
truktivt. Modellens laebe haengte en smule til venste side, og
jeg rettede det med Liquify’'s Pucker Tool.

Generative Fim =

Original stgrrelse

Stock

Rentegning

Layers

Q Search Al

oY > [Hl rentegning
© a|> i original

Fritlagt med Pen Tool

Convert to Smart Object

o !l model copy
]
o. Smart Filters

o Liquify

o P roce

Liquify...
Vanishing Point...

Fritlagt med Select and Mask
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Mask All Objects.
Create Clipping Mask

Filter  View Plugins  Window
Last Filter
Convert for Smart Filters

Grafik & Billedbehandling

Sammenklipning

Fritlagde solbrillernes glas og lavede det til paths. Derefter
markede jeg dem og lavede en layer maske med begge glas
pa. For at fa gjne ind i min solbrille maske, lavede jeg en rough
selection om hvert gje, og sa clipping mask til hvert gje. Lavede
solbrillernes glas med et gradient layer og brugte Hard Light
(blend mode).

Neural Filters - Colorize

De gjne jeg ville bruge kom fra et greyscaled billede. For at
ggre det farvet, lavede jeg det til et Smart Object, hvorefter jeg
gik ind under Filtrer, Neural Filters og sa Colorize.

Lysne gjne

For at give mere livi gjnene, lavede jeg fgrst en figur af det
lyseste af hendes gje med Pen Tool. Derefter markerede jeg
det, og fyldte en midlertidig rgd farve i. Tilfgjede Gaussian Blur
og brugte en layer maske til at fijerne steder jeg ikke gnskede
havde effekten (kanten og midten af gjet). Jeg aendrede farven
til en lysere grgn og puttede Screen (blend mode) pa for at fa
ginene til at poppe.

High Pass

For at fjerne rander under gjnene, lavede jeg en kopi af ori-
ginalen og kaldte laget for "hud”. Gik ind under Filtrer, Other
og High Pass. Lavede et nyt lag under "High Pass”, samlede
farver op omkring hendes gjne og malede med en meget blgd
brush, der hvor hendes mgrke rander var fgr. Skruede ned for
opaciteten for at fa et mere naturligt look.

Farvejustering

Nogle af billederne havde rgd, gul eller bla stik og det @endrede
jeg med Hue/Saturation under adjustment layers. Derefter har
jeg justeret med et Solid Color lag, hvor jeg har eye droppet fra
hudfarven og lysnet med et Soft Light blending mode.

Clone Stamp

Jeg har brugt Clone Stamp for at fa mere fylde i modellens
frisure. Derudover har jeg brugt Levels og Solid Color til at til-
fgje dybde og lys i haret.
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Grafisk Produktionsforstaelse

Process Tidslinje
Overblik over min arbejdsprocess.

Seperations Preview

For at sikre der ikke er steder, der giver problemer ift. sprog-
skifte. Ved fejl, har jeg tilfgjet Multiply pa den sorte for ikke at
fa mispas.

Mappestruktur

For at bevare overblikket, har jeg lavet en mappestruktur, sa
det er nemt at navigere i.

Papirstype

Omslag

170 gram Silk-papir giver en staerkere (holdbar) fornemmelse,
hvilket beskytter indholdet og giver produktet en premium-
fglelse. Det sikrer omslaget mod slid og hyppig handtering,
mens det fgles kvalitetsbetonet.

Indmad

100 gram Silk-papir er let og fleksibelt, ideelt til at skabe et
glat, laesevenligt indhold uden at virke for tungt. Kombination
af dem balancerer holdbarhed og elegance, hvilket giver et
praktisk og stilfuldt produkt.

Sprogskifte

Ved at bevare layoutet (farver, billeder, grafik) pa CMY-pla-
derne og kun zendre teksten pa den sorte plade (K), slipper
man for at lave nye plader til de tre andre farver (CMY). Det er
billigere og tidsbesparende at udskifte én plade i stedet for
fire. Jeg har bevidst undgaet negative tekster, for at undga
sprogvarianter i CMY.

300 ppi

Eftersom magasinet skal trykkes, er alle billederne tjekket til at
vaere 300 ppi for at sikre en laekker billedkvalitet. Det er gjort
inde i Photoshop under Image, Image Size.
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Grafisk Produktionsforstaelse

Marketing Plan

For at have et overblik over plan og ikke mindst budgettet,
lavede jeg en marketingsplan.

Conditional Text

Har brugt Conditional Text til sprogskifte for tidsbesparelse og
mindre risiko for fejl fremfor at rette i to seperate kataloger.

Preflight

Oprettede en ny preflight ved navn Katalog under "Define
Profiles”, for at se om filen var klar til tryk.

Links

» Hvisder er links til billeder eller lignende der mangler.

Colour

» Slog Lab og HSB farver fra, da de ikke er relevante for mit
katalog. Derudover har jeg ogsa sagt, at teksten aldrig ma
sta i "Registration”, da det er spild af blaek.

Image & Objects

* Advarer om billeder overholder den minimume ppi (250)
som er sat bliver holdt og hvis billederne er scalet upro-
portionalt, mm.

TEXT

» Sgrger for, at der var styr pa min tekst, fonte og glyphs.

Document

« Sgrger for, at der er styr pa mine sider, bleed mm.

PDF Preset

Gik ind under File, Adobe PDF Presets, PDF/x-4:2008. Det
hjeelper med at undga uforudsete problemer ved tryk, som
2ndrede farver eller fejl i grafik, og sikrer hgj kvalitet i det en-
delige trykte produkt. Den PDF form kan ogsa handtere RGB,
CMYK og SPOT color.

General & Marks

Single Pages er sldet til, da trykkerne har deres eget system ift.
korrekt sideopsaetning. Under Marks har jeg sldet Crop Marks
til for at vise, hvor siderne skal beskaeres efter print.

Output - Color Conversion

Convert to Destination (preserve numbers) for at bevare far-
verne sa taet som muligt pa de oprindelige veerdier. Destina-
tion er sat til Coated FOGRA39, som er en standard-farveprofil.
Pa den made kan jeg sikre mig, at farverne bliver printet tro
til skeermen.



Digital Produkt beskrivelse

Dette er en fiktiv case

Case

Azzaro har i mange ar brugt flere summe af penge pa at hyre
flere kendte og smukke modeller til at veere ansigtet til deres
parfumereklamer. Tiderne aendre sig og folk er mere draget
af autensistet.

Firmaet gnsker at ggre deres malgruppe bredere og have fat i
de unge fyre i midt 20’erne som ikke har noget imod at bruge
penge pa at finde den helt rigtige parfume.

Krav

Parfumen, der skal reklameres for er deres "The Most Wan-
ted” parfume. Reklamen skal fgres pa YouTube og videoen
ma maks vare 30 sekunder. Da de er et luksurigst brand, er
budgettet ikke et stort problem. Dog gnsker de at bevare en
form for jordneerhed og bruge en del penge pa promovering
af reklamen.

Budget
Omkring 27.000 til 32.000

Kernefagligheder
- Grafisk Design
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Grafisk Design

Research - Hvad og Hvem?
Fgrst startede jeg med at researche produktet som jeg skulle
saelge. Derudover sporede jeg mig ind pa malgruppen.

Brandscript Script

Jeg har lavet en Brandscript Script for at kommme teettere ind
pa firmaet- og malgruppens gnsker.

Storyboard

Jeg lavede et storyboard med mine idéer for at fa et visuelt
billede af reklamen sa jeg huskede at filme alt nar jeg befandt
mig pa settet.

Arbejdsprocess - Designudvikling
Overblik over min designprocess.

Stemning

Da malgruppen er unge fyre, ville jeg gerne have, at reklamen
skulle veere spontan, fartrig og stilren.

Jeg ville szelge en stemning, hvor der er en form for mystik/
uvished i starten. Produktet bliver Igsningen til sidst og viser,
at alt man vil er muligt.

Nggleord:

e Kontraster
* Leeder

» Cool

e Fart

» Rat

Farver og kontraster

Alle farver og kontraster blev redigeret med adjustment layers
sajeg arbejede non destruktivt. For at bevare Azzaro's stilrene
identitet, gik jeg med et look, der satte fokus pa kontraster.
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AZZARO

main accords

warm spicy
amber
sweet
woody
caramel
aromatic

Moderne Segment
Moderne-individorienterede

Individorienterede
Malgruppe:

¢ Maendimidt20'erne
» Tgr at ga pa ukendt grund
» Garopikvalitet, alenetid, fart, motor
sport, formel 1, musik .
* Hader stilhed, ventetid "’

Platform: Youtube (1920 x 1080 pixels)
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Designkoncept
bliver udviklet

Research

Case modtages

Feedback
implementeres

Storyboard
bliver klargjort

Kundefeedback

Original klip

Rettet med Lumetri Color




SERVICE DESIGN THINKING SERVICE DESIGN DOING Attention

NN ing:

W\ Handling:
Hvor er han

pd vej hen?

) Sneak Peak
/ af produktet

Musikken skifter,
humgret og
stemningen bliver
mere selvsikker

Udvikling af
produkter

Interest
-

PROBLEM/
TRIGGER

DISCOVER DEFINE DEVELOP DELIVER SOLUTION .

Desire

VISION
& PLAN

Research; Hvem skal
jeg ramme? Lgser mine feerdige

produkter problemet?

Afsender og CTA

Lukkefase; Mdalgruppen
findes, idéer indsnaevres

Jjet feres naturligt fra Tilt , Extreme Close Shot

den skarpe genstand
i forgrunden til den
slgrede motorcykel i
baggrunden.

Close Shot

e
.

Ses 00:20 i reklamen

Patos 00:.08

Etos 00:26

Azzaro - Since 1967. Discover your signature scent now.

Wwww.azzaro.com
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Grafisk Design

Double Diamond

Jeg har brugt Double Diamond modellen, for at bevare over-
blikket og have en struktureret proces. Modellen far en til at
huske at starte bredt for at forsta casen ("problemet”) og der-
efter fokusere malrettet pa én Igsning.

AIDA

¢ Attention: 00:01
¢ Interest: 00:05
* Desire: 00:08

* Action: 00:26

Komposition

Til sidst for at seette fokus pa produktet en gang for alle, brugte
jeg deledendelinjer for at skabe et interessant fokuspunkt og
lede kundens gjne gennem kompositionen.

Perspektiver

For at skabe en god dynamik i reklamen, valgte jeg at bruge
forskellige vinkler og perspektiver. Iszer frgperspektiv blev
brugt meget for, at kunden fik en fornemmelse af at se op
til manden.

Gestaltlovene

¢ Loven om naerhed - 00:05: ser vi hovedpersonen holde
produktet i handen. Det skaber en relation mellem pro-
duktet og hovedpersonen..

« Loven om kontinuitet - 00:01: Her ser vi hovedpersonen, der
gar fra et close up bagved til et close up fra siden.

Patos, Etos og Logos

¢ Patos: Jeg valgte at fokusere og bruge patos mest, da jeg
ville sselge en stemning og en Igsning til kundens behov
for selvtillid.

» Etos: Ved at skrive arstallet ved min CTA, viser det hvor lang
tid brandet har levet og skaber derved tillid til kunden.

» Logos: Jeg valgte ikke at bruge logos fordi jeg ville undga
at distancere seeren med for meget logik og i stedet skabe
en mere intim, sanselig og personlig oplevelse.






